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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published October 2010. 

© 2010 Deltek, Inc. 

Deltek‘s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Deltek GCS Premier Version 5.0 Service Pack (SP) 9 
Overview 

This document contains new and upgrade installation instructions for Deltek GCS Premier Version 
5.0 SP9. The installer has been updated to support new platform-related changes in GCS Premier. 
In addition to installation instructions, this document includes the following information: 

 Support of the Latest Microsoft Platforms 

 Information to read before you begin, including: 

o Whether you should perform an upgrade installation or a new installation 

o One-time procedure you must perform to access the hidden ProgramData folder 
in order for GCS Premier to function properly 

 Premier Billing installation modifications. 

 GCS Premier uses the industry standard InstallShield application to guide 
you through the installation process. 

GCS Premier no longer supports Windows 2000 with GCS Premier Version 
5. Please see the Product Support Matrix section below for detailed system 
requirements. 

Support of the Latest Microsoft Platforms 

With this release, Deltek announces support for the latest Microsoft
®
 platforms. GCS Premier 5.0 

SP9, Premier Billing, and GCS Premier Web Reports now all support the following:  

 Windows Server
®
 2008 (including R2) (32-bit and 64-bit in WOW64 mode) 

 Windows
®
 7 (32-bit and 64-bit in WOW64 mode) 

 Windows Vista™ (32-bit and 64-bit in WOW64 mode) 
  

 
Support for 64-bit is provided through Windows® 32-bit On Windows 64-
bit (WOW64), an emulation layer that enables 32 bit Windows-based 
applications to run seamlessly on 64-bit Windows 

 
  

 
See the GCS Premier 5.0 SP9 Release Notes for details. 

  

Before You Begin 

Before you begin your GCS Premier 5.0 SP9 installation, you need to: 

 Determine whether you should perform an upgrade installation or a new installation 

 Perform a one-time procedure to access the hidden \ProgramData folder in order for GCS 
Premier to function properly 

Additionally, review the GCS Premier 5.0 SP9 Release Notes to learn about the following:  
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 New installation path for GCS Premier programs 

 New location for DTLocal.ini file 

When to Perform a New or Upgrade Installation 

The Windows platform you use determines whether you perform an upgrade or new installation, as 
detailed below. For example, though you may currently use GCS Premier 5.0 SP7, if you are using 
Windows Vista, you need to run a new installation. See below for details. 

You must be running GCS Premier Version 4.1 SP8 or higher, or GCS Premier Version 5.0 SP3 or higher 
prior to installing the Version 5.0 SP9 upgrade. If the installer does not detect GCS Premier Version 4.1 
SP8 or higher, or GCS Premier Version 5.0 SP3 or higher, an error messages will appear and the 
installation will exit.   

Use an Upgrade Installation if… 

You are currently running GCS Premier Version 4.1 SP8 or higher, or GCS Premier Version 5.0 SP3 or 
higher, and you use one of the following Windows platforms: 

 Windows XP 

 Window Server 2003 
  

 An Upgrade Installation automatically uninstalls Programs and System folders from the current 
version, and then proceeds with 5.0 SP9 installation. 

  

 If you have a version lower than GCS Premier Version 4.1 SP8 (or above), or lower then GCS 
Premier Version 5.0 SP3 (or above), you need to manually uninstall it first, and then run GCSP 5.0 
SP9 installer as a New Installation. Upgrading from lower versions for these platforms is not 
supported. See the ―New Installation‖ section later in this document  for details.  

  

Use a New Installation if… 

You want to install GCS Premier 5.0 SP9 on one of the following Windows Platforms: 

 Windows Vista (32-bit or 64-bit) 

 Windows 7 (32-bit or 64-bit) 

 Windows Server 2008 (32-bit or 64-bit) 
  

 If you have GCS Premier (5.0 SP7 and lower) installed on these platforms, you need to manually 

uninstall it first, and then run GCSP 5.0 SP9 installer. Upgrading from lower versions for these 
platforms is not supported. See the ―New Installation‖ section later in this document  for details.  

  

Accessing the Hidden \ProgramData Folder 

\ProgramData is a hidden folder in Windows Vista, Windows 7 and Windows Server 2008. In order to 
view this folder in Windows Explorer, the Admin user must enable the display of hidden files through 
Folder and Search Options. 

  

 You must perform this one-time procedure in order to properly display currently hidden files through 
Folder and Search Options. 
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 On Windows Server 2008, Windows 7, and Windows Vista, files that are installed into the 
%SystemDrive%\ProgramData folder also appear in the %SystemDrive%\Users\All Users 
folder.  By default, the %SystemDrive%\Users\All Users folder is an alias (junction) to the 
%SystemDrive%\ProgramData folder for backwards compatibility, and does not represent a 

second copy of files. The files that appear in both locations are the same. 

 

To show hidden folders, follow these steps:  

1. Open Windows Explorer, click Computer » Local Disk C: (or whichever drive your local 
Windows operating system resides on, typically C:).  

 

2. Click Organize » Folder and search options. 
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3. Select the View tab, then select the radio button next to Show hidden files, folders and drives. 

 
  

 This is a one-time procedure. Once this option is set, it shows \ProgramData and all the other 
hidden files and folders in the local machine.  

If you need to disable the hidden folders, follow the steps above, but select Do not show hidden 
files and folders. 
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Folder Structures 

Deltek recommends that you use the standard folder structure described below. The use of the standard 
folder structure assists Deltek‘s Technical and General Support analysts to respond to issues effectively 
and efficiently when you call for support. In addition, future software and data upgrades will be easier to 
perform if you use the standard folder structure. 

Server Folder Structure 

The following is the standard folder structure for a server installation.  

Common Name(s) Suggested Location 

GCS Premier Site (server) 
Parent folder 

\\ServerName\ShareName\Deltek\GCSPremier 

Documents Folder \\ServerName\ShareName\Deltek\GCSPremier\Documents 

PMData folder \\ServerName\ShareName\Deltek\GCSPremier\PMData 

PMReport folder \\ServerName\ShareName\Deltek\GCSPremier\PMReport 

Setup folder \\ServerName\ShareName\Deltek\GCSPremier\Setup 

SiteData folder \\ServerName\ShareName\Deltek\GCSPremier\SiteData 

Startup folder \\ServerName\ShareName\Deltek\GCSPremier\Startup 

Data folder \\ServerName\ShareName\GCSPremier\Startup\Data 

Sys1W32 (toolkits) folder \\ServerName\ShareName\Deltek\GCSPremier\Sys1W32 

Programs folder (server copy) \\ServerName\ShareName\Deltek\GCSPremier\Programs 

System folder (server copy) \\ServerName\ShareName\Deltek\GCSPremier\System 

Client Folder Structure 

The standard folder structure for a client installation is provided below.  
  

 You can use any local drive letter (C:, D:, and so on) to follow the standard folder structure. 

  

 

Common Name(s) Suggested Location 

GCS Premier Parent folder GCS Premier (formerly installed in the C:\Program Files 
directory) is now installed on the following path, depending on 
platform version.  

Windows Server 2003 – <%SystemDrive%>\Documents and 

file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
file://ServerName/Share
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Common Name(s) Suggested Location 

Settings\All Users\Application Data\Deltek\GCSPremier 

Windows XP – <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier 

Windows Vista (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

Windows Server 2008  (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

Windows 7 (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

Programs folder <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier\Programs 

<%SystemDrive%>\ProgramData\Deltek\GCSPremier\Programs 

System folder <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier\System 

<%SystemDrive%>\ProgramData\Deltek\GCSPremier\System 

Folder Descriptions 

GCS Premier Parent folder — The Parent folder contains all of the folders created by the installation. 

Documents folder — Release information documentation may be placed in this folder. 

PMData folder — This folder contains the configuration files for Process Manager. If you did not choose 
to install Process Manager this folder will be empty. 

PMReports folder — This folder contains the reports created via Process Manager. If you did not choose 
to install Process Manager or have not run any processes that created output this folder will be empty. 

Setup folder — This folder contains subfolders that hold the previous installations for all releases of GCS 
Premier. 

SiteData folder — This folder contains files that are shared between multiple Startup folders for those 
clients with Multiple Company Licenses installed. This folder also contains the DTSITE.INI file.  

Startup folder — This folder contains files that are shared between multiple data folders as well as the 
DTSHARED.INI file.  

Data folder — This is the default data folder created by the initial installation of GCS Premier. You can 
rename or move this folder. Multiple data folders, such as prior year and prior month audit folders, backup 
folders, and test data folders, are permitted.  

Sys1W32 (toolkits) folder — This folder holds applications that are called by the Miscellaneous 
Functions screen within GCS Premier. 
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New Installation 

This section is intended for new GCS Premier users who intend to install GCS Premier 5.0 SP9 for the 
first time, or users who want to install GCS Premier 5.0 SP9 on one of the following Windows Platforms: 

 Windows Vista (32-bit or 64-bit) 

 Windows 7 (32-bit or 64-bit) 

 Windows Server 2008 (including R2) (32-bit or 64-bit) 

The installation of Deltek GCS Premier is a two-part installation.  

 Part one is the Server Installation, which is performed only once.  

 Part two is the Client Installation, which you must perform on each individual workstation that 
will be running GCS Premier.  

 Network Installation Note: System administrators can elevate users‘ privileges 
at their local workstations to Administrator level, enabling users to perform their 
own software installations at their workstations. With the Network Installation 
feature, the system administrator does not have to go to each workstation and 
perform the Programs Installation for users. 

In this scenario, when GCS Premier is launched, the program automatically 
informs the user of an updated version on the server. The users then install the 
upgrade on their workstation by following the prompts. Please see the ―Programs 
Installation‖ section of this document for more details. 

Before You Begin  

Reinstalling the Programs Installation of GCS Premier on a Workstation 

Occasionally the Programs Installation (client) of GCS Premier needs to be uninstalled/reinstalled for 
various reasons, such as the workstation registry and/or workstation operating system may have become 
corrupted; the workstation's GCS Premier program files may have become corrupted; there is a mismatch 
between the .exe and .dll files called by that screen; or the .dll file may not have completed registration 
correctly during installation.  

If for any reason you find that you need to uninstall the Programs Installation of GCS Premier, please 
refer to the ―Known Issues‖ section of the Deltek GCS Premier 5.0 Service Pack 8 Release Notes for 
detailed steps.  

Clients with Custom Programming 

If you have custom programming, do not install GCS Premier Version 5.0 SP9. Contact your Account 
Manager for further information. 

Backups 

Perform a complete backup of the GCS Premier Parent folder and all of its subfolders, as well as a 
complete backup of all GCS Premier Data folders prior to upgrading. 
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Multiple Company Data Folders 

For those clients that have multiple data folders for multiple companies, the installation automatically 
performs any necessary updates to all data folders listed in all DTSHARED.INI files in all company 
Startup folders that are listed in the [CompanyDirectories] section of your DTSITE.INI file.  

Please contact GCS Premier Customer Care if you have any questions regarding the setup and/or 
update for multiple companies and their data directories. 

Preliminary Questions 

During the installation process, you will be asked the following questions. Please review the questions 
below and decide how to answer them prior to beginning the actual installation. 

Browse to DTSite.ini — The DTSite.ini file is located in the \SiteData folder, which resides underneath the 
GCS Premier ‗Parent‘ folder on the server. This path should auto-populate during the installation process. 

Select Additional Features — Select additional features to install. 

You will be presented with the option to install additional Deltek products that work with (but are not a part 
of) GCS Premier. None are required to run GCS Premier successfully. Highlight each product to see a 
brief description of that product. 

These products are available at no cost to all clients, but do require additional dedicated resources and 
hardware to run. More detailed information on both products can be found on our Deltek Customer Care 
Connect site, or you can contact your Account Manager or GCS Premier Customer Care. 

  

 These products can be installed at a later date independent of the GCS Premier Version 5.0 SP9 
installation by running the Version 5.0 SP9 installation process again and choosing to modify the 
program. 

Error Messages  

If you receive an error message during the installation of this update, please contact Deltek Customer 
Care for assistance. 

Pre-Installation 

You must be running GCS Premier Version 4.1 SP8 or higher, or GCS Premier Version 5.0 SP3 or higher 
prior to installing the Version 5.0 SP9 upgrade. If the installer does not detect GCS Premier Version 4.1 
SP8 or higher, or GCS Premier Version 5.0 SP3 or higher, an error messages will appear and the 
installation will exit.   

If you have a version lower than GCS Premier Version 4.1 SP8, or lower than GCS Premier Version 5.0 
SP3, you need to manually uninstall it first, and then run GCSP 5.0 SP9 installer as a New Installation. 
Upgrading from lower versions for these platforms is not supported.  

Prior to installing GCS Premier 5.0 SP9, you need to do the following: 

 Uninstall existing GCS Premier software, if required (see above). 

 Be sure that the Server Installation is performed at the file server itself, while logged in with 
Administrator privileges. 

 Manually create the GCS Premier Parent folder and add the Administrator account to the 
Security tab with Full Control permissions on Windows Server 2008. 
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 All installations should be installed as the user who will be running GCS Premier on that 
Workstation / Terminal Server / File Server machine, and that user must have local Administrator 
privileges on the machine at the time of installation in order to successfully perform the 
installation. If the user does not currently have local Administrator privileges on the Workstation / 
Terminal Server / File Server machine, temporarily grant the user local Administrator privileges 
and perform the installation. Remember to restore the users' privileges back to what they 
previously were upon completion.   

 If multiple profiles share the Workstation / Terminal Server / File Server machine and will be 
running GCS Premier, the Programs Installation will need to be run once for each profile, and 
that profile must have local Administrator privileges on the machine at the time of installation in 
order to perform the installation successfully. 

 As a Domain Administrator the account automatically has permissions at the NTFS level, but the 
account needs to be manually granted permissions to the share. Be sure to add the Domain 
Administrator account to the "Security" tab for the share that the GCS Premier 'Parent' folder 
resides on. 

 Recent Windows security updates have been hiding the C:\Program Files\InstallShield Installation 
Information folder and then GCS Premier cannot determine the installed version and errors are 
received. Please ensure this folder is not hidden and the user performing the installation has 
permissions to access this folder (and its subfolders) during the installation process.   

 Make sure that you have your company license file (GL07GLN.DAT) available, and know its 
location. 

 Download the executable file onto the file server‘s Desktop. 

Uninstall Software 

Before you begin the process of installing GCS Premier 5.0 SP9, you must uninstall existing GCS Premier 
demo software and/or non-upgradeable versions of GCS Premier (see ―When to Perform a New or 
Upgrade Installation‖ section above for details).  

To uninstall the GCS Premier DemoSoftware: 

1. Click Start » Control Panel. 

2. Click Add or Remove Programs. 

3. Select the Deltek GCS Premier or Deltek Demo GCS Premier program and click Remove. 

Create Local Parent Folder and Grant ―Full Control‖ Permissions  

If you intend to install the Application Program Files on a Windows 2008 server machine during the 
Server Installation (if you intend to use this server as a workstation for GCS Premier or for remote 
access), you must first create the local Parent folder and add the Administrator account to the Security 
tab with ―Full Control‖ permissions, otherwise an error will occur during the installation (―Access is 
denied‖), and permissions will not propagate through the sub-folders correctly.  
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To manually create the GCS Premier Parent folder and add the Administrator account to the Security tab 
with ―Full Control‖ permissions on Windows Server 2008, do the following: 

1. Ensure you are logged in as the Network/Domain Administrator. 

2. Open Windows Explorer, then under the Computer section, expand Local Disk (C:) (or 
whichever drive your Windows operating system is installed on), then click on the \ProgramData 
folder. 

 

3. Click New Folder, then re-name the new folder Deltek. 

4.  Right-click on the newly-created Deltek folder, choose Properties » Security.   

5. Click Edit. 
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6. Select Administrators (Machine_Name\Administrators) from the Group or user names list, 
then check the Allow box next to the Full control permission in the Permissions for 
Administrators list.   

7. Click Apply, then OK, twice, to exit the Properties screen. 

 

 



New Installation  

12 

 

 

 If multiple profiles will share the GCS Premier program on the File Server, the Programs 

Installation will need to be run once for each profile, and that profile must have local 
Administrator privileges on the File Server at the time of the installation to perform the installation 

successfully.  

 

 To install and run GCS Premier, you do not need to grant permissions to individual users 
if the Group they are a member of has been granted permissions at the Group level.  The 
Administrators group needs to be granted ―Full Control‖ permissions (for installation 
purposes), and the Standard User group needs ―Modify‖ rights added to the default rights 
assigned to that group to run the application successfully.  

Company License File 

During installation, you will be required to select the path where the Company License File 
GL07GLN.DAT is located, or insert the CD that contains the file, then browse to the location of the CD 
drive. Make sure that you have this file and information available prior to installation. 

Download the Executable File 

Download the DeltekGCSPremier50SP9.exe file from the distribution site at 
https://deltek.custhelp.com/app/Distribution.  

New Server Installation 

1. Begin the upgrade installation of GCS Premier Version 5.0 SP9 with the Server Installation. 
After you download the DeltekGCSPremier50SP9.exe from the distribution site, double-click the 
file to begin the installation. 

 The installation of Deltek GCS Premier Version 5.0 SP9 requires a reboot of the file 
server upon completion. 

The Welcome to the InstallShield Wizard page displays.  
  

https://deltek.custhelp.com/app/Distribution
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2. On the InstallShield Wizard page, click Next to extract the files and begin the installation. The 
following page displays. 

 

This page is followed by the Preparing Setup page. 
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The following message appears: 

 

3. Click Yes. The Browse DTSite.ini page displays. 

 

4. This first request for Browse DTSite.ini is used to determine if this is a New Installation or an 
Upgrade Installation.  Browse to the root of the C: drive (C:\), then click Next to continue. 
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The following warning may appear. 

 

If you are installing on a stand-alone XP, Vista, or Windows 7 workstation, or a Windows Server 
2003 or 2008 file server, click OK.  

  

 GCS Premier Version 5.0 SP9 requires that the Server Installation be performed at the 

file server itself, rather than from a workstation to the file server, if performing a 
Client/Server Installation. Ensure the Server Installation is performed on the file server 

machine directly. 

The following page displays.  

 

5. On the Welcome… page, click Next to display the License Agreement page. 
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6. If you agree with the License Agreement stated on the License Agreement page, select ―I 
accept the terms of the license agreement‖ and then click Next. If you do not accept the terms of 
the license agreement, the Next button will not become illuminated and you will not be allowed to 
proceed with the installation.  

 
Installation of the software indicates acceptance of these terms, unless there 
is a separate written license agreement for the software you are now installing 
with different or additional terms. By accepting the agreement, you represent 
that you are authorized to accept these terms on behalf of the licensee, if 
applicable. 

If you accept, the following page displays. 
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7. On the Select Features page, select the check boxes to install Server Components, Application 
Program Files (if you intend to use this server as a workstation for GCS Premier or for remote 
access), Process Manager Files, and/or Web Reports, and then click Next.  

These features can be installed at a later date independent of the GCS Premier Version 5.0 SP9 
installation by running the Version 5.0 SP9 installation process again and choosing to ―Modify‖ 
the program. 

 

   

 

Make your selections and click Next. The following page displays.  

 

8. On the Deltek GCS Premier Choose Destination Location page, browse to the location where 
you want your GCS Premier Parent folder installed. 

  

 

 

 

Process Manager and Web Reports are not part of the GCS Premier program and are 
not required for GCS Premier to function. Highlight each product to see a brief 
description of that product. These products are available at no cost to clients, but do 
require additional dedicated resources and hardware to run. More detailed information 
on both products can be found on our e-Support site, or you can contact your Account 
Manager or GCS Premier Customer Care. 

  

  

 Process Manager can be installed independent of Web Reports, but Web Reports cannot 
be installed without Process Manager, as it requires Process Manager to perform its 
functions. 
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 The Parent folder serves as the central network directory for storing the GCS 
Premier data files, licenses, and other shared information for each licensed 
company. This Parent folder also includes a subfolder that stores the Setup 
programs used to install the GCS Premier programs on your users‘ workstations.  

Although you are technically installing the software on the server‘s local drive (for 
example, C: or D :), be sure to browse to the drive via ―My Network Places‖ so 
that the UNC path to the location of the folders on the server will be written into 
the INI files. Failure to browse to the location via ―My Network Places‖ causes you 
to have to manually edit all of the paths in the INI files before you perform the 
―Client‖ (workstation) portion of the installation. 

When you click Browse, the following screen displays. 

 

Browse through ―My Network Places‖ to select the location of the ‗Parent‘ folder. Click OK to 
accept the location, then click Next to continue.   

 

 

 

 If the GCS Application files are installed to a UNC path on Server 2008, Windows 7 or 
Windows Vista, when you launch GCS, you may get a UAC prompt from the Operating 
System that a network application wants to make changes to your machine.  This is 
normal since to the OS the application is running from a UNC path. 
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The following page displays.  

 

9. On the Define Company Startup Directories page, click Next to accept the default 
name/location of the company Startup folder. 

If performing a multi-company installation, click Add to select the locations of all the different 
company Startup folders. Once all of the additional company Startup folders have been added, 
click Next. 

The Define Data Directories page displays. 

 

10. On the Define Data Directories page, click Next to accept the default name/location of the 
company Data folder. 

If performing a multi-company installation, use the Add button to select the locations of all the 
different company Data folders. Once all of the additional company Data folders have been 
added, click Next. 
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The Company Name Disk page displays.  

 

11. The Company Name Disk screen appears. Click Browse to select the path where the Company 
License File GL07GLN.DAT is located, or insert the CD that contains the file, then browse to the 
location of the CD drive and click OK. 

If performing a multi-company installation, you will be prompted to insert each of the CDs for each 
of the companies for which you will be performing the installation. 

The Start Copying Files page displays.  
  

 

12. The Start Copying Files page lists the previous options that were selected as well as the folders 
that are created as part of the installation. Click Next to begin the installation of the GCS Premier 
Server Installation. The following displays.  
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The Setup Status page displays and, once completed, a series of processes run. When the 
Server Installation is complete, the following page displays. 

 

13. Select ―Yes, I want to restart my computer now‖ to restart your computer as required by the 
Installer. Click Finish to exit the installation. 
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 For full GCS Premier functionality, the following needs to occur: 

 Reboot the machine. 

 Share the GCS Premier Parent folder and its subfolders, as well as the Data 
folder, with all users and grant users all rights except ―Full Control‖ to these 
folders.  

 Ensure none of the folders and/or the files within the folders have been flagged 
read-only. 

  

If you choose ―No, I will restart my computer later‖ on this screen, the following message will 
appear but then the installation will complete and allow you to exit. 
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New Client Installation 

Run the Client Installation (local programs) on each workstation where you will install GCS Premier 
Version 5.0 SP9.  

To perform the Client Installation, grant users local Administration privileges for their workstations. Then 
at each workstation, log in as the user who will be running GCS Premier on that workstation, and perform 
the installation. Additionally, if multiple profiles share the workstation and will be running GCS Premier, 
grant each profile Administrator privileges on the workstation, and run the Client Installation once for 
each profile.  

  

 New Client installations require that you manually launch the upgrade installation by browsing to the 
―Setup\V5.00.0000SP9‖ folder on the server (located underneath the GCS Premier Parent folder). 

  

 

1. Double-click the SETUP.EXE file. Once the upgrade is launched, the following page displays. 
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The following page displays. 

 

2. Click Yes. The Browse DTSite.ini page displays. 

 

3. This first request for Browse DTSite.ini is used to determine if this is a New Installation or an 
Upgrade Installation.  Browse to the root of the C: drive (C:\), then click Next to continue. 

The Welcome… page displays.  
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4. On the Welcome page, click Next to display the License Agreement page. 

 

5. If you agree with the License Agreement stated on the License Agreement page, select ―I 
accept the terms of the license agreement‖ and then click Next. If you do not accept the terms of 
the license agreement, the Next button will not become illuminated and you will not be allowed to 
proceed with the installation.  

 
Installation of the software indicates acceptance of these terms, unless there 
is a separate written license agreement for the software you are now installing 
with different or additional terms. By accepting the agreement, you represent 
that you are authorized to accept these terms on behalf of the licensee, if 
applicable. 
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If you accept, the following page displays. 

 

6. On the Choose Destination Location page, accept the default location that auto-populates, then 
click Next to continue.  

  

 Default locations for GCS Premier Parent folder vary by platform, as follows: 

 Windows Server 2003 – <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier 

 Windows XP – <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier 

 Windows Vista (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

 Windows Server 2008  (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

 Windows 7 (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

  

The Site Wide Directory page displays.  
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7. On the Deltek GCS Premier Site Wide Directory page, browse to the \SiteData folder, located 
underneath the GCS Premier Parent folder on the server. Click Next to continue. 

 

8. The Start Copying Files page lists the previous options that were selected as well as the folders 
that are created as part of the installation. Click Next to begin. 
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8. The Setup Status page displays. Once completed, the following page displays:  

 

9. Select Yes, I want to restart my computer now to restart your computer as required by the 
Installer. Click Finish to exit the installation. 

  

 For full GCS Premier functionality, you must reboot the machine.  
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If you select No, I will restart my computer later, the following message displays but then the 
installation completes and allows you to exit.  
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Upgrade Installation 

You must be running GCS Premier Version 4.1 SP8 or higher, or GCS Premier Version 5.0 SP3 or higher 
prior to installing the Version 5.0 SP9 upgrade. If the installer does not detect GCS Premier Version 4.1 
SP8 or higher, or GCS Premier Version 5.0 SP3 or higher, an error messages will appear and the 
installation will exit.   

If you have a version lower than GCS Premier Version 4.1 SP8, or lower than GCS Premier Version 5.0 
SP3, you need to manually uninstall it first, and then run GCSP 5.0 SP9 installer as a New Installation.  

Perform an upgrade installation if you currently have GCS Premier Version 4.1 SP8 (or higher) installed, 
or GCS Premier Version 5.0 SP3 (or higher) installed, and you are running it on one of the following 
Windows platforms: 

 Windows XP 

 Window Server 2003 
  

 An Upgrade Installation automatically uninstalls the current version, and then proceeds with the 5.0 
SP9 installation.  A screen will appear stating ―Setup is configuring GCS Premier installation‖ during 
this process.  This screen will stay on screen for quite a while, do not assume the installation is 
hung up at this point. 

The installation of Deltek GCS Premier is a two-part installation.  

 Part one is the Server Installation, which is performed only once.  

 Part two is the Client Installation, which you must perform on each individual workstation that 
will be running GCS Premier.  

 Network Installation Note: System administrators can elevate users‘ privileges 
at their local workstations to Administrator level, enabling users to perform their 
own software installations at their workstations. With the Network Installation 
feature, the system administrator does not have to go to each workstation and 
perform the Programs Installation for users. 

In this scenario, when GCS Premier is launched, the program automatically 
informs the user of an updated version on the server. The users then install the 
upgrade on their workstation by following the prompts. Please see the ―Programs 
Installation‖ section of this document for more details. 

 

 

Before You Begin 

Reinstalling the Programs Installation of GCS Premier on a Workstation 

Occasionally the Programs Installation (client) of GCS Premier needs to be uninstalled/reinstalled for 
various reasons, such as the workstation registry and/or workstation operating system may have become 
corrupted; the workstation's GCS Premier program files may have become corrupted; there is a mismatch 
between the .exe and .dll files called by that screen; or the .dll file may not have completed registration 
correctly during installation.  

If for any reason you find that you need to uninstall the Programs Installation of GCS Premier, please 
refer to the ―Known Issues‖ section of the Deltek GCS Premier 5.0 Service Pack 9 Release Notes for 
detailed steps.  
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Clients with Custom Programming 

If you have custom programming, do not install GCS Premier Version 5.0 SP9. Contact your Account 
Manager for further information. 

Backups 

Perform a complete backup of the GCS Premier Parent folder and all of its subfolders, as well as a 
complete backup of all GCS Premier data folders prior to upgrading. 

Multiple Company Data Folders 

For those clients that have multiple data folders for multiple companies, the installation automatically 
performs any necessary updates to all data folders listed in all DTSHARED.INI files in all company 
―Startup‖ folders that are listed in the [CompanyDirectories] section of your DTSITE.INI file. 

Please contact GCS Premier Customer Care if you have any questions regarding the setup and/or 
update for multiple companies and their data directories. 

Prerequisites  

You must be running at least GCS Premier Version 4.1 SP8, or GCS Premier Version 5.0 SP3 or higher 
prior to installing the Version 5.0 SP9 upgrade. If the installer does not detect at least GCS Premier 
Version 4.1 SP8, or GCS Premier Version 5.0 SP3 or higher, one of the following error messages will 
appear and the installation will exit:  

 

 

If you have a version lower than GCS Premier Version 4.1 SP8, or lower than GCS Premier Version 5.0 
SP3, you need to manually uninstall the version first, and then run GCSP 5.0 SP9 installer as a New 
Installation.  

You must perform the Server Installation at the file server machine itself while logged in to the file server 
with an account that has full rights (such as the Network Administrator or the Domain Administrator) to the 
GCS Premier Parent folder (and its subfolders), as well as to any GCS Premier data folders. 

The Client Installation must be installed while logged in as the user who will be running GCS Premier on 
that workstation, and that user must have local Administrator privileges on their own workstation to 
perform the installation. Additionally, if multiple profiles share the workstation and will be running GCS 
Premier, the Client Installation will need to be run once for each profile, and that profile must have local 
Administrator privileges on their own workstation to perform the installation. 

 On Windows XP, Vista and Windows 7 workstations — If the user does not currently have 
local Administrator privileges on their own workstation, grant them local Administrator privileges 
temporarily and manually perform the installation. Then set their privileges back to what they 
previously were. 
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Client/Server Installations 

GCS Premier Version 5.0 SP9 requires that the Server Installation be performed at the file server itself, 
rather than from a workstation to the file server, if performing a Client/Server Installation. Ensure the 
Server Installation is performed on the file server machine directly. 

During installation on the server, although you will technically be installing the software on the server‘s 
local drive (such as C: or D :), be sure to browse to the drive via ―My Network Places‖ so that the UNC 
path to the location of the folders on the server will be written into the INI files. Failure to browse to the 
location via ―My Network Places‖ will cause you to have to manually edit all of the paths in the INI files 
before you perform the ―Client‖ (workstation) portion of the installation. 

Preliminary Questions 

During the installation process, you will be asked the following questions. Please review the questions 
below and decide how to answer them prior to beginning the actual installation. 

Browse to DTSite.ini — The DTSite.ini file is located in the \SiteData folder, which resides underneath the 
GCS Premier ‗Parent‘ folder on the server. This path should auto-populate during the installation process.  

Select Additional Features — Select additional features to install. 

You will be presented with the option to install additional Deltek products that work with (but are not a part 
of) GCS Premier. None are required to run GCS Premier successfully. Highlight each product to see a 
brief description of that product. 

These products are available at no cost to all clients, but do require additional dedicated hardware to run. 
More detailed information on both products can be found on our Deltek Customer Care Connect site, or 
you can contact your Account Manager or GCS Premier Customer Care. 

  

 These products can be installed at a later date independent of the GCS Premier Version 5.0 SP9 
installation by running the Version 5.0 SP9 installation process again and choosing to modify the 
program. 

Error Messages 

If you receive an error message during the installation of this update, please contact Deltek Customer 
Care for assistance. 

Pre-Installation 

You must be running at least GCS Premier Version 4.1 SP8, or GCS Premier Version 5.0 SP3 or higher 
prior to installing the Version 5.0 SP9 upgrade. If the installer does not detect at least GCS Premier 
Version 4.1 SP8, or GCS Premier Version 5.0 SP3 or higher, an error message will appear and the 
installation will exit.   

If you have a version lower than GCS Premier Version 4.1 SP8, or lower then GCS Premier Version 5.0 
SP3, you need to manually uninstall it first, and then run GCSP 5.0 SP9 installer as a New Installation. 
Upgrading from lower versions for these platforms is not supported.  

Prior to installing GCS Premier 5.0 SP9, you need to do the following: 

 Uninstall existing GCS Premier software, if required (see above). 

 Be sure that the Server Installation is performed at the file server itself, while logged in with 
Administrator privileges. 
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 All installations should be installed as the user who will be running GCS Premier on that 
Workstation / Terminal Server / File Server machine, and that user must have local Administrator 
privileges on the machine at the time of installation in order to successfully perform the 
installation. If the user does not currently have local Administrator privileges on the Workstation / 
Terminal Server / File Server machine, temporarily grant the user local Administrator privileges 
and perform the installation. Remember to restore the users' privileges back to what they 
previously were upon completion.   

 If multiple profiles share the Workstation / Terminal Server / File Server machine and will be 
running GCS Premier, the Programs Installation needs to run once for each profile, and that 
profile must have local Administrator privileges on the machine at the time of installation in order 
to perform the installation successfully. 

 As a Domain Administrator the account automatically has permissions at the NTFS level, but the 
account needs to be manually granted permissions to the share. Be sure to add the Domain 
Administrator account to the Security tab for the share that the GCS Premier Parent folder 
resides on, if it has not already been done. 

 Recent Windows security updates have been hiding the C:\Program Files\InstallShield Installation 
Information folder and then GCS Premier cannot determine the installed version and errors are 
received. Please ensure this folder is not hidden and the user performing the installation has 
permissions to access this folder (and its subfolders) during the installation process.   

 Download the executable file onto the file server‘s Desktop. 

 To install and run GCS Premier, you do not need to grant permissions to individual users 
if the Group they are a member of has been granted permissions at the Group level.  The 
Administrators group needs to be granted ―Full Control‖ permissions (for installation 
purposes), and the Standard User group needs ―Modify‖ rights added to the default rights 
assigned to that group to run the application successfully.  

Uninstall Software 

Before you begin the process of installing GCS Premier 5.0 SP9, you must uninstall existing GCS Premier 
demo software and/or non-upgradeable versions of GCS Premier (see ―When to Perform a New or 
Upgrade Installation‖ section above for details).  

To uninstall the GCS Premier DemoSoftware: 

1. Click Start » Control Panel. 

2. Click Add or Remove Programs. 

3. Select the Deltek GCS Premier or Deltek Demo GCS Premier program and click Remove. 

Download the Executable File 

Download the DeltekGCSPremier50SP9.exe file from the distribution site at 
https://deltek.custhelp.com/app/Distribution.  

Upgrade Server Installation 

1. Begin the upgrade installation of GCS Premier Version 5.0 SP9 with the Server Installation. 
After you download the DeltekGCSPremier50SP9.exe from the distribution site, double-click the 
file to begin the installation. 

https://deltek.custhelp.com/app/Distribution
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 The installation of Deltek GCS Premier Version 5.0 SP9 requires a reboot of the file 
server upon completion. 

 

 

The Welcome to the InstallShield Wizard screen displays.  

  

 

2. On the InstallShield Wizard page, click Next to extract the files and begin the installation. The 
following page displays. 

 

The Installer checks for and deletes previous installations, if necessary.  The message below will 
stay on the screen for quite some time during this process, do not assume the installation has 
hung up at this point. 
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If data files are found in the \Programs or \System folder, the following warning displays: 

 

If this warning displays, create another copy of your data files outside of the \Programs or 
\System folder, and then delete the copy that currently exists inside of the \Programs or \System 
folders to resume the installation. 

The following page displays. 

 

3. If you have a version lower than GCS Premier Version 4.1 SP8, or lower then GCS Premier 
Version 5.0 SP3 (or above), you need to manually uninstall it first, and then run GCSP 5.0 SP9 
installer as a New Installation. If you are upgrading from one of the supported upgrade versions, 
click Yes. The Browse DTSite.ini page displays. 
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10. On the Deltek GCS Premier Browse DTSite.ini page,the correct location of the DTSite.ini file 
should be displayed. If this path does not auto-populate, please browse to the \SiteData folder, 
located underneath the GCS Premier ‗Parent‘ folder on the server.  Click Next to continue. 

The following warning may appear.  

 

If you receive the message above, click OK to proceed past the warning.  
  

 GCS Premier Version 5.0 SP9 requires that the Server Installation be performed at the 

file server itself, rather than from a workstation to the file server, if performing a 
Client/Server Installation. Ensure the Server Installation is performed on the file server 

machine directly. 

The Welcome… page displays.  

 

4. On the Welcome… page, click Next to display the License Agreement page. 
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5. If you agree with the License Agreement stated on the License Agreement page, select ―I 
accept the terms of the license agreement‖ and then click Next. If you do not accept the terms of 
the license agreement, the Next button will not become illuminated and you will not be allowed to 
proceed with the installation.  

 
Installation of the software indicates acceptance of these terms, unless there 
is a separate written license agreement for the software you are now installing 
with different or additional terms. By accepting the agreement, you represent 
that you are authorized to accept these terms on behalf of the licensee, if 
applicable. 

If you accept, the following page displays: 
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6. On the Deltek GCS Premier Choose Destination Location page, browse to the location where 
your GCS Premier Parent folder is currently installed, or click Next to accept the default folder if it 
is accurately displayed. 

  

 The Parent folder serves as the central network directory for storing the GCS 
Premier data files, licenses, and other shared information for each licensed 
company. This Parent folder also includes a subfolder that stores the Setup 
programs used to install the GCS Premier programs on your users‘ workstations. 
A copy of the GCS Premier Programs Installation will also be installed on the 
file server. 

Although you will technically be installing the software on the server‘s local drive 
(such as C: or D:), be sure to browse to the drive via ―My Network Places‖ so that 
the UNC path to the location of the folders on the server will be written into the INI 
files. Failure to browse to the location via ―My Network Places‖ will cause you to 
have to manually edit all of the paths in the INI files before you perform the Client 
(workstation) portion of the installation. 

  

If you click Browse, the following screen displays. 

 

 

Browse through ―My Network Places‖ to select the location, click OK to accept it, then click Next 
to continue. 



Deltek GCS Premier® 5.0 Service Pack 9 Upgrade Installation Guide 

 

39 

 

The following page displays. 

 

7. On the Deltek GCS Premier Browse DTSite.ini page,the correct location of the DTSite.ini file 
should be displayed. If this path does not auto-populate, please browse to the \SiteData folder, 
located underneath the GCS Premier ‗Parent‘ folder on the server.  Click Next to continue. 

 

8. On the Select Features page, select the check boxes to install Server Components, Application 
Program Files (if you intend to use this server as a workstation for GCS Premier or for remote 
access), Process Manager Files, and/or Web Reports, and then click Next to continue.  

  

 

 

 

Process Manager and Web Reports are not part of the GCS Premier program and are 
not required for GCS Premier to function. Highlight each product to see a brief 
description of that product. These products are available at no cost to clients, but do 
require additional dedicated resources and hardware to run. More detailed information 
on both products can be found on our Deltek Customer Care Connect site, or you can 
contact your Account Manager or GCS Premier Customer Care. 
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These features can be installed at a later date independent of the GCS Premier Version 5.0 SP9 
installation by running the Version 5.0 SP9 installation process again and choosing to ―Modify‖ 
the program. 

 

 

 

The following page displays: 

 

9. The Start Copying Files page lists the previous options that were selected as well as any new 
folders that are created as part of the installation. Click Next to begin the installation of the GCS 
Premier Server Installation.  

 

  

 Process Manager can be installed independent of Web Reports, but Web Reports cannot 
be installed without Process Manager, as it requires Process Manager to perform its 
functions. 
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10. The Setup Status page displays and, once completed, a series of processes are run. When the 
Server Installation is complete, the following page displays. 

 

11. Select ―Yes, I want to restart my computer now‖ to restart your computer as required by the 
Installer. Click Finish to exit the installation. 

  

If you choose ―No, I will restart my computer later‖ on this screen, the following message will 
appear but then the installation will complete and allow you to exit. 
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Upgrade Client Installation 

Run the Client Installation (local programs) on each workstation where you will install GCS Premier 
Version 5.0 SP9.  

To perform the Client Installation, grant users local Administrator privileges for their workstations. Then 
at each workstation, log in as the user who will be running GCS Premier on that workstation, and perform 
the installation. Additionally, if multiple profiles share the workstation and will be running GCS Premier, 
grant each profile Administrator privileges on the workstation, and run the Client Installation once for 
each profile. 

On Windows XP, Vista and Windows 7 workstations — If the user does not currently have local 
Administrator privileges on their own workstation, grant them local Administrator privileges temporarily 
and manually perform the installation. Then set their privileges back to what they previously were. 

Setup will automatically uninstall the previous version of GCS Premier from your workstation (if required), 
then will launch the Client Installation immediately and without interruption.  

1. To begin the upgrade installation, double-click the GCS Premier icon on the desktop. The 
following Error Report message appears. Click Close to close the message and begin the 
installation. 

 

2. The following message appears. Click Yes. 

 

Alternately, you can manually launch the upgrade installation by browsing to the 
―Setup\V5.00.0000SP9‖ folder on the server (located underneath the GCS Premier Parent folder) 
and double-click the SETUP.EXE file.   
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3. Once the upgrade is launched, the Preparing Setup page displays.  

 

4. The Installer checks for and deletes previous installations, if necessary.  The message below will 
stay on the screen for quite some time during this process, do not assume the installation has 
hung up at this point. 
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5. If data files are found in the \Programs or \System folder, the following warning displays: 

 

If this warning displays, create another copy of your data files outside of the \Programs or 
\System folder, and then delete the copy that currently exists inside of the \Programs or \System 
folders to resume the installation. 

The following page displays. 

 

6. If you have a version lower than GCS Premier Version 4.1 SP8, or lower then GCS Premier 
Version 5.0 SP3, you need to manually uninstall it first, and then run GCSP 5.0 SP9 installer as 
a New Installation. If you are upgrading from one of the supported upgrade versions, click Yes. 
The Browse DTSite.ini page displays. 
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7. On the Deltek GCS Premier Browse DTSite.ini page,the correct location of the DTSite.ini file 
should be displayed. If this path does not auto-populate, please browse to the \SiteData folder, 
located underneath the GCS Premier Parent folder on the server. Click Next to continue. 

The Welcome… page displays.  

 

On the Welcome page, click Next to display the License Agreement page.  
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8. If you agree with the License Agreement stated on the License Agreement page, select ―I 
accept the terms of the license agreement‖ and then click Next. If you do not accept the terms of 
the license agreement, the Next button will not become illuminated and you will not be allowed to 
proceed with the installation.  

 
Installation of the software indicates acceptance of these terms, unless there 
is a separate written license agreement for the software you are now installing 
with different or additional terms. By accepting the agreement, you represent 
that you are authorized to accept these terms on behalf of the licensee, if 
applicable. 

If you accept, the following page displays: 

 

9. On the Choose Destination Location page, accept the default location that auto-populates, then 
click Next to continue.  

  

 Default locations for GCS Premier Parent folder vary by platform, as follows: 

 Windows Server 2003 – <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier 

 Windows XP – <%SystemDrive%>\Documents and Settings\All 
Users\Application Data\Deltek\GCSPremier 

 Windows Vista (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

 Windows Server 2008  (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 

 Windows 7 (32-bit or 64-bit) – 
<%SystemDrive%>\ProgramData\Deltek\GCSPremier 
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The Site Wide Directory page displays. 

 

10. On the Deltek GCS Premier Browse DTSite.ini page,the correct location of the DTSite.ini file 
should be displayed. If this path does not auto-populate, please browse to the \SiteData folder, 
located underneath the GCS Premier Parent folder on the server. Click Next to continue. 

 

11. The Start Copying Files page lists the previous options that were selected as well as any new 
folders that are created as part of the installation. Click Next to begin. 
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12. The Setup Status page displays. Once complete, the Update Complete page displays. 

 

13. Select Yes, I want to restart my computer now to restart your computer as required by the 
Installer. Click Finish to exit the installation. 

 For full GCS Premier functionality, you must reboot the workstation.  

If you select No, I will restart my computer later, the following message displays but then the 
installation completes and allows you to exit. 
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Post-Installation  

50 

 

 

Post-Installation 

You must complete the following instructions after installing GCS Premier. 

1. Check each workstation to ensure that the GCS PDF Driver was installed. To do so, click Start » 

Control Panel » Printers and Other Hardware » View installed printers or fax printers and 
see if the GCS PDF Driver is listed there.  

The driver allows the user to Print/Print Preview from within GCS Premier in PDF format. You 
cannot print directly to the GCS PDF Driver from within GCS Premier, and it will not work with any 
other application. 

  

 If the GCS PDF Driver printer is not shown once the Programs Installation is complete, 

the program was most likely not installed by users with local Administrator privileges on 
their own workstations. If they do not currently have local Administrator privileges on their 
own workstations, grant them local Administrator privileges temporarily and manually 
perform the installation, then set their privileges back to whatever they were prior to 
temporarily changing them. 

  

2. Within Deltek GCS Premier, display the Set Up Data Files screen (System Administration » 
File Utilities), click the down-arrow in the Files box, and choose <All>. Click Set Up, and let it 
run through all of the files.  

 

Note: This step must be performed in every data directory listed in your Data Directory 

drop-down box on the login screen. 

3. This step is for Travel users only. If you do not use this product, please skip this step. 
Within Deltek GCS Premier, proceed to the Update Per Diem File screen (Travel/Setup Files). 
Click the Process button and then click OK when you receive the ―Processing Completed‖ 
message. 

Windows XP Professional Impact Printer Users 

You may experience problems while printing Purchase Orders (Form 1412). The following information 
may be truncated:  Page, Ship Via, Ship To Address, Quantity Received, Quantity Back Order. If this is 
happening to you, you need to set up a new printer that uses a custom form on the workstations that print 
Purchase Orders (Form 1412).  

If you are using Windows 2000 or higher, see the following section for instructions. 

To set up in a new printer that will use this custom form, please perform the following steps: 

1. Log on to the workstation with a local profile with Computer Administrator rights. Otherwise, you 
will not be able to add a new printer. 

2. Click Start/Settings/Control Panel. Select Printers and Faxes. 

3. Click File/Add Printer and add a printer with the exact same properties as the existing impact 
printer. Name this new printer Print PO Form 1412. Set the Print PO Form 1412 printer as the 
default printer. 

To create a custom form for printing Purchase Orders (Form 1412), follow these steps: 

1. Click Start/Settings/Control Panel. Select Printers and Faxes. 

2. Click File/Server Properties. On the Forms tab, select the Create A New Form check box. 
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3. In the Form Name text box, enter 9.8 x 11. 

4. Set the Units to English, and set all Printer Area Margins to 0.00in. In the Paper Size/Width text 
box, enter 9.80in. In the Paper Size/Height text box, enter 11.00in. 

5. Select Save Form. Select Close. 

To set up your newly-created custom printer to use your custom form, please perform the 
following steps: 

1. Click Start/Settings/Control Panel. Select Printers and Faxes. 

2. Right-click on the Print PO Form 1412 printer, then select Properties. 

3. On the Device Settings tab, within the Form To Tray Assignment section, set each paper source 
to use your new 9.8 x 11 custom form. 

4. Select Apply, then OK. 

Use the Print PO Form 1412 when printing Purchase Orders (Form 1412): 

1. Within GCS Premier, go to Material Management/Purchasing & Receiving/P.O. Process/Print 
Purchase Orders (Form 1412). 

2. Click File/Print. Your Print PO Form 1412 printer should appear in the window as your default 
printer.  

3. Select Properties. Go to the Paper/Quality tab and select Advanced. 

4. Under the Paper/Output section, set the Paper Size to your new 9.8 x 11 custom form. 

5. Select OK three times to get back to the Purchase Orders (Form 1412) and print your Purchase 
Orders. 

Windows 2000 and Higher Impact Printer Users 

Some checks/advices may print incorrectly. The first check/advice will print correctly; however 
subsequent checks/advices may begin printing towards the bottom of the form. If this occurs, set up a 
new printer that uses a custom form on workstations that print checks and/or advices.  

To create a custom form for printing checks and/or advices, follow these steps: 

1. Click Control Panel » Printers. 

2. Select the File menu, then select Server Properties. 

3. On the Forms tab, select the Create A New Form check box. 

a. In the Form Description for text box, enter 8.5 x 7. 

b. In the Paper Size Width text box, enter 8.5. 

c. In the Paper Size Height text box, enter 7. 

d. Select Save Form or OK. 

4. Select Close. 

To set up a new printer in Windows 2000 (and higher) that will use this new custom form, follow 
these steps: 

1. Click Control Panel » Printers. 
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2. On the Printers form, select Add Printer. Create a printer using the same properties as the 
impact printer you already have. Provide a name that clearly identifies it as either the printer used 
solely for printing checks/advices (such as Check/Advices Impact Printer) or one that is used 
solely for printing 1099s (such as Form 1099 Impact Printer). 

3. On the Printers form, right-click the printer you just created, and then select Properties. 

4. On the General tab, select Preferences. 

5. On the Paper Quality tab, select Advanced, and then in the Paper Size drop-down list, select the 
new custom form. 

6. Select OK. 

Use the appropriate new printer when printing checks and advices. 

Excel Format Add-In 

In order to use the features to format Excel spreadsheets (such as. Show Page Break, Roll-Up Page 
Header and Show Grid Lines) there is a simple one-time only manual setup that is required. To perform 
this setup, follow the step by step instructions below. 

1. Start Excel 2003 or Excel 2007.  

2. In Excel 2003, click Add-Ins on the Tools menu. 

3. In Excel 2007, click Microsoft Office Button, click Excel Options, and then click Add-Ins. Click 

Excel Add-ins in the Manage list box, and then click Go.  

4. In the Add-Ins dialog box, click to select the GCSP Settings check box or the GSRPTLYT check 

box, and then click OK. (Note: If the box next to GSRPTLYT or GCSP Settings is already 

checked, uncheck it and click OK, then run steps 1-3 again to get back to the Add-Ins dialog box 

and check the box.  Once checked, click OK.) 

5. If neither GCSP Settings or GSRPTLYT appear in the Add-Ins dialog box, select Browse and 

browse to the location of the GSRPTLYT.XLA file (typically located at C:\Program 

Files\Deltek\GCS Premier\Programs or C:\Program Files\Deltek\GCSPremier\Programs (no 

space between GCS and Premier), whichever you chose during installation).  Highlight the 

GSRPTLYT.XLA file and click OK. 

This will automatically create a checkbox for GCSP Settings or GSRPTLYT (depending on your version of 

Excel) in the Add-Ins settings. Make sure there is a check in the box beside GCSP Settings or 

GSRPTLYT, whichever appears. Note that  

  

 A GCS Premier Settings button now appears in the tool bar. 

  

Add-On Modules 

If you have recently purchased any add-on module, please contact Deltek‘s Distribution Department at 
(877) HLP-PROJ to get a software key, if you have not already done so. The software key is necessary in 
order to be able to use the newly purchased add-on modules under GCS Premier.  
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The installation is complete! 

If you have any questions, please contact GCS Premier Customer Care at 877/HLP-PROJ. 
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Process Manager  

Functionality Diagram 

The Process Manager handles processing requests, allowing you to offload your process intensive jobs to 
a faster central station, freeing up your own workstation. Run on a shared computer between users, this 
enhancement benefits everyone using Deltek GCS Premier. 

Process Manager called from LAN 

 

 

 

 

 

 

 

Prerequisites 

Process Manager is specialized software to be installed on a computer on which Deltek GCS Premier 
Version 5.0 SP9 is already installed. Typically, no one interactively uses GCS Premier on this shared PC. 
This shared PC responds to report and process requests from many users. This PC and the GCS 
Process Manager must be up and running in order for those requests to be processed.  

A queue is a list of reports and processes that people have submitted to the Process Manager. The 
Process Manager can service many queues. Queues can also be serviced by many Process Managers. 

Since a Process Manager can service requests from many GCS Premier users, we anticipate that our 
clients would only set up a few Process Managers, possibly only one in total. Please consider how many 
PCs, and which ones, should have the Process Manager software installed before you continue. 
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Typical Configurations of Process Managers and Queues 

Fig. 1: One PC Running Two Process Managers 

When one PC is running two process managers, GCS Premier users are assigned to one of two queues. 
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Fig. 2: Two PCs Running One Process Manager 

In this example, the first PC is for LAN use, serving two groups of users. The second PC is for Web 
Reports requests. 

The Process Manager is also an integral part of the Deltek Web Reports module. If you decide to 
implement the Web Reports module, we recommend that you set up a PC servicing only the Web queue 
to allow the best response time.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Existing Deltek Process Manager Users 

If you have installed Deltek Process Manager for a prior version of Deltek GCS Premier, do not manually 
uninstall it. This installation automatically detects a previous Process Manager installation, notifies you 
that a previous installation was detected, and automatically uninstalls it before installing the newer 
version.  

Please make sure that any/all existing Process Managers jobs in the queues have been completed before 
installing this latest Deltek Process Manager installation. 
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Post Installation 

User ID and Password 

Please use the following new default User ID and Password for the Process Manager:  

Default User Id = PMUSER 

Default Password= PASSWORD 

This allows you to enter the Process Manager Admin and Process Manager Configuration screens via the 
Start » Programs » Deltek GCS Premier program group. 

1. For existing Process Manager users, access the Deltek GCS Process Manager Configuration 
screen.  

2. From the Queues tab, enter the appropriate L or W value under the column called Queue Type by 
selecting whether the current queue is for jobs submitted from a Local Area Network (L) or if you 
are using Web Reporting (W). 

  

 If you are setting up the "GCSRPC" queue, mark it as a Web queue. 

  

3. Please review the Process Manager help accessed via the Help button under the Process 
Manager Admin and Process Manager Configuration screens.  
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GCS Web Reporting 

GCS Web Reporting provides another method to access all the reports available in GCS Premier. Using 
this product, you can run reports and processes via the web.  

GCS Web Reporting works hand-and-hand with the Process Server. Jobs run through GCS Web Reports 
are submitted to a Process Server for execution reducing the workload of the Web Server. Output from 
reports and processes is displayed in GCS Web Reports in PDF format. 

Requirements 

Server Requirements 

 Windows 2000/2003/2008 Server 

 Web applications can be restarted without bringing down Web Server 

 Terminal Services to remotely administer IIS 

 GCS PDF Driver 
  

 If your network policies do not allow Kernel Mode Drivers (Windows 2003 Server default 
setting), contact support for a non-kernel mode driver. 

  

 Internet Information Server (IIS) version 5.0 or higher 

 When installing IIS 7.0 using the Server Manager on Windows Server 2008, you need to 
install both ASP.NET and ASP to run Web Reports. 

 Available with Windows 2000/2003 

 Firewall (if Internet, not Intranet) 

 Data Server 

Workstation Requirements 

Browser 

Internet Explorer 5.5 Service Pack 2 (and above) 

Delete Cookies and Delete Files  

Netscape 6.2 (and above) 

Clear Memory Cache and Clear Disk Cache 

Set browser to look for newer version of cached file  

Portable Document Format (PDF) reader (i.e., Adobe® Acrobat® Reader®) 

Login 

You will need to enter login information similar to Deltek GCS Premier.  
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 You must have an active Process Server that‘s polling the ―GCSRPC‖ queue to log on to GCS Web 
Reporting. The special ―GCSRPC‖ queue is used by the server for remote procedure calls within 
GCS Web Reporting, such as processing login requests and lookups. If you are unable to load the 
login screen in your browser after typing in the correct address, verify you have started a server 
polling the ―GCSRPC‖ queue. After activating the server, use the Refresh button in your browser to 

try and load the login screen again. 

  

Use the Login button to enter the site or Reset to clear login selections.  

After you select the Login button, a new page is displayed with a menu on the left and the right filled with 
the GCS splash image. The right half of the screen is overlaid with parameter selections once you select 
a report on the menu. The right side is overlaid again with the report in PDF format once you submit your 
selections for a report. All login information excluding password is echoed near the top of this page. You 
can also have your company logo display at the top. 

  

 To display your logo near the top of the application page. Be sure to back up the client.gif file found 
in \images under the GCS Web Reports root directory. Place a copy of your logo image, which must 
be stored as a gif at a size of about inch-and-half wide by three quarters of an inch in height, in the 
\images directory. Rename the .gif with your image to client.gif. Once GCS Web Reports is 
refreshed, you will see your image near the top on the application page. 

  

After you have logged on, you may notice you still have a minimized instance of the login screen open. If 
you click it, a Web page containing only the GCS Premier splash screen displays. Do not close it. Doing 
so shuts down GCS Web Reporting.  

Use the maximize button on the toolbar at the top of the browser page to expand the screen to the largest 
size available. 

User ID 

Enter the ID that you use when logging on to Deltek GCS Premier.  

Password 

Enter the password that you use when logging on to Deltek GCS Premier.  

Company 

Select the Company for which you want to generate a report. All companies stored under the 
CompanyDirectories section of the dtsite.ini file will be available to choose from. 

Entry ID 

Enter the Entry ID that you use when logging on to Deltek GCS Premier. The value and whether the field 
is editable is based on the settings in Maintain Entry Ids * User Profiles.  

Data Directory 

Select the Data Directory for which you want to view the data on reports. All data directories stored under 
the DataDirectories section of the dtshared.ini will be available to choose from. 
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GCS Web Reporting Menu 

The GCS Web Reporting Menu Is loaded with all the modules and applications you have rights to use. 
Some reports exist in multiple modules where applicable, so do not be alarmed if you see a report under 
more than one module. If you have rights to run a report in one module, you will have rights to run it from 
any other module - even if you do not have rights to run any other applications in the module. 

Use the scroll bar on the right to move up and down through the menu. To expand or collapse the width 
of the menu, place your cursor over the vertical line between the application portion of the screen and the 
menu. The cursor appears as a line with an arrow on either end. Press and hold your left mouse button 
and drag the line either right to expand, or left to shrink the menu. 

+All 

Use this selection to expand all the menu items. 

 -All 

Use this selection to collapse all the menu items. 

Show All 

Selection this option to show all menu items including those you do not have rights to open. Non-available 
menu items are grayed-out (displayed in light gray text).  

Show Mine 

If you select this option, you can view only menu items you have rights to see. This selection is available 
only when Show All has been used to expand the menu.  

Global Toolbar 

This toolbar contains icons for common global functionality. 

Back 

Moves back one screen in history. Reports are not retained in history; use the Show Previous Reports 
drop-down to view a previously run report. 

Forward 

Moves forward one screen in history. Reports are not retained in history; use the Show Previous Reports 
drop-down to view a previously run report. 

Help 

Select this option to link to Deltek GCS Premier help files. Help files are stored in html format so they will 
be displayed through a web page. 

Close 

Use the Close option to shut down GCS Web Reporting. Any reports generated for this session will be 
deleted from the web server. 
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Report Selections 

After you have selected a report from the menu, the selection criteria displays in the right portion of the 
screen. The selection criteria is similar to the Deltek GCS Premier LAN version of the application, 
including control types such as text fields, radio buttons, and checkboxes. Help text for a field, if available, 
displays on the status text bar at the bottom of the screen when focus is on a field.  

After filling in the selection criteria, select Submit to run the report. Submit creates an entry in the 
Process Queue file that will be immediately executed on the Process Server. If no errors are 
encountered, a report is produced in PDF format and displayed in the right hand portion of the screen. If 
errors do occur, instead of a report, you receive information regarding the nature of the error. Again, 
displayed in the right hand portion of the screen. If the error is a warning, you may choose to ignore the 
warning and re-run the report otherwise the error may be canceled.  

  

 After you press Ignore to a warning message, you must press the Submit button again to run the 

report ignoring warnings. 

The Process Server must be up and running for the queue to which you are submitting Web jobs. 
Also, any user running web reports must have a web queue established in the Users & Passwords 
screens in the Users, Profiles, and Security module of Deltek GCS Premier. See the Process 
Server Configuration documentation to determine how best to set up queues for your company. 

  

After submitting a report, you see the progress bar near the bottom of the application page. If the process 
appears stalled (especially when you know a report or process should run quickly), check to see if the 
Web server has been shut down. If so, you‘ll have to run your report again at a later time once the Web 
server is restored. Also, verify that a Process Server is available to service your job. If you start a Web 
report without a Process Server available or to a queue not currently serviced by a Process Server, have 
your administrator start the Process Server or establish the queue on a running Process Server and the 
report will be produced (provided the web session has not timed out). 

Application Toolbar 

This toolbar contains icons for application specific functionality. 

New 

Use this option to clear any values entered for report selections. 

Submit 

Use this option to submit the report to the Process Server. You then either view the report in PDF format 
or an error report. 

Close 

Select this option to close the current report or selection screen.  

Lookup 

If focus is on a field in the selection criteria that has a lookup, the Lookup button will be visible. Select 
this button to load a lookup dialog to select a value from. (Note: The special ―GCSRPC‖ or remote 
procedure call queue is used to process the Lookup as well as handle logging on to GCS Web 
Reporting.) 
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Lookups in GCS Web Reporting, allow you to search for values to populate a report selection. Using 
Lookup, you can enter Starting With criteria to narrow your search. Also, lookups may have filters or Sort 
By options. Use the Search button to display values meeting search criteria or use Clear to refresh your 
selection criteria. A table window in the middle of the page displays the lookup values. Use the Previous 
or Next buttons to move through the available rows of the lookup table. To select a row, highlight it and 
then select OK or double click on a row to bring the value into the screen. Use Cancel to close the page 
without selecting any value. 

Calendar 

If focus is on a field in the selection criteria that represents a date, the Calendar button is visible. Select 
this button to load a calendar to view a current of future month, day, and year. 

Calendar in GCS Web Reporting, provides you with a calendar control that allows you to view a particular 
month, day, and year. Use the arrows to the left and right of the month and year to move through the 
calendar. Select OK to choose the date. Use Cancel to close the calendar down without selecting any 
value. Today moves the calendar to the current date. 

Previous Reports 

Use this drop-down to access any reports run during the current web session. All reports are deleted 
once you log out or if the Web server times out.  

User Preferences 

Select the User Preferences menu item beneath Configuration to pick a color scheme for Web Reports. 
You must log out of Web Reports and log on again to see the color change. Your user preference is 
stored locally on your client machine so each user is able to view GCS Web Reports i 
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Deltek Product Support Compatibility Matrix 

Overview 

The Deltek Product Support Compatibility Matrix contains updated information on the latest tested 
versions for the key technologies used by Deltek products. This information is designed to give you 
guidance on product deployment. The section below contains definitions for the fields that are found 
within the matrix. 

Embedded Technology 

This column lists the key embedded technologies used to develop the Deltek application.  These 
technologies are distributed and supported by Deltek.  Changes to these technologies are infrequent 
since these changes can require extensive changes to the underlying applications. 

Supported Deployment Technology 

This column lists the currently actively tested versions of technologies used to deploy Deltek products.  
These technologies are not embedded or directly supported by Deltek.  Changes to these technologies 
occur at the discretion of the individual technology vendors.  Deltek‘s testing of specific versions of 
deployment technologies is indicated by that technology version being included in this column.  In the 
case of database technologies, Deltek will test a specific version of a database product with a specific 
platform, available in our QC environment.  We will support users of that database version on any 
platform supported and listed as compatible by the database vendor.  Deltek will make its best effort to 
assist with platform questions for a tested database version but may be unable to address some 
questions on platforms not used by Deltek for testing. 

Compatible Deployment Technology 

This column lists recent previously supported and tested technologies used to deploy the Deltek product.  
These are not actively being tested but are believed to be compatible with the indicated Deltek product 
and version.  Deltek does not recommend these technologies for new deployments but will make its best 
effort to answer questions concerning these technologies.  These technologies may not be available for 
troubleshooting at Deltek. 

New Technology Supported with this Release 

This column lists the recently added versions of technologies used to deploy the referenced Deltek 
product version.  These technologies are a subset of the technologies listed in the Supported Deployment 
Technology column.  

Technology De-Supported with this Release 

This column lists technologies which are no longer supported with the Deltek product.  Deltek does not 
recommend these technologies for deployments of the Deltek product version and cannot support 
deployments using these technology versions. 
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Product Support Matrix 

This section includes detailed product support requirements and hardware requirements for Deltek GCS Premier 5.0 (5.00.0000) and above.  

Hardware Requirements: 

 Processor: 400 MHz Pentium processor or equivalent (minimum) 

 1GHz Pentium processor or equivalent (recommended) 

 RAM: 256 megabyte (MB) RAM or higher 

 Hard Disk: Up to 600 MB of available space may be required (NTFS formatted) 

 CD or DVD Drive: Not required 

 Display - 1024 x 768 high-color, 32-bit 
  

 
Our 64-bit support is for x64, and not the 64-bit Itanium processors 
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GCS Premier 5.0 Server Requirements 

Product 
name 

Embedded 
Technology 

Supported Deployment Technology 
Compatible  Deployment 
Technology 

New Technology 
Supported with this 
Release 

Technology De-
Supported with 
this Release 

Last 
Modified 

GCS Premier 
5.0 SP8 

 The recommended minimum software 
requirements for a complete installation of 
Deltek GCS Premier include: 

 

Operating Systems (NTFS Formatted 
Partitions only) 

 
o Windows Server 2008 R2 
o Windows Server 2008  

32-bit (x86), 64-bit (x64) 
o Windows Server 2003 with Service 

Pack 2 (SP2)  
32-bit (x86)  only 

 

Web Server (GCS Premier Web 
Reporting) 

 
o IIS 7.5 
o IIS 7.0 
o IIS 6.0 

Operating Systems 

 
o Windows 2000 Server 

with Service Pack 4 
(SP4) 

 

Web Server (GCS Premier 
Web Reporting) 

 
o IIS 5.0 

Operating Systems 

 
o Windows Server 

2008 R2 
o Windows Server 

2008  
32-bit (x86), 64-bit 
(x64) 

 

Web Server (GCS 
Premier Web Reporting) 

 
o IIS 7.5 
o IIS 7.0 

 07/19/10 
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GCS Premier 5.0 Client Requirements 

Product 
name 

Embedded 
Technology 

Supported Deployment Technology 
Compatible Deployment 
Technology 

New Technology 
Supported with this 
Release 

Technology De-
Supported with this 
Release 

Last 
Modified 

GCS Premier 
5.0 SP8 

 The recommended minimum software 
requirements for the client workstation 
include: 
 
Operating Systems (NTFS Formatted 
Partitions only), 32-bit (x86), 64-bit (x64)   
o Windows 7 
o Windows Vista with Service Pack 2 

(SP2) 
o Windows XP Professional with 

Service Pack 3 (SP3) 

 

Other  

Business Applications 
o Microsoft Office 2007 SP2  

 

Web Browser (GCS Premier Web 
Reporting) 
o Internet Explorer 8.0 

 

Terminal Services/Remote Desktop 
Services 
o Windows Server 2008 R2 
o Windows Server 2008 

32-bit (x86)  or 64-bit (x64) 
o Windows Server 2003 (32-bit only) 

 Operating Systems 

Other 

Business Applications 
o Microsoft Office 2003 
o Microsoft Office 2002/XP 

 

Web Browser 
o Internet Explorer 6.0 

(and above) 
o Netscape 6.2 (and 

above) 

 

Business Applications 
o Microsoft Office 2007 

SP2 

 

Web Browser (GCS 
Premier Web Reporting) 
o Internet Explorer 8.0 

 Operating Systems 
o Windows 2000 

Professional with 
Service Pack 4 
(SP4) 

 

Other Business 
Applications 
o Microsoft Office 

2000 

Web Browser 
o Internet Explorer 

5.5  

 

07/19/10 
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Additional (Optional) Client Requirements – Premier Billing Version 5.0 

Product 
name 

Embedded 
Technology 

Supported Deployment Technology 
Compatible Deployment 
Technology 

New Technology 
Supported with this 
Release 

Technology De-
Supported with this 
Release 

Last 
Modified 

GCS Premier 
5.0 SP8 

 
Premier 
Billing 

Infragistics Net 
Advantage 2007 
components 

 

The recommended minimum software 
requirements for the Premier Billing v5.0 
client workstation include: 
 
Operating Systems (NTFS Formatted 
Partitions only),  

32-bit (x86), 64-bit (x64)   
o Windows 7 
o Windows Vista with Service Pack 2 

(SP2) 
o Windows XP Professional with 

Service Pack 3 (SP3) 

 

Other  

Business Applications 
o Microsoft Office 2007 Service 

Pack 2 with Hotfix KB980210  
(Premier Billing requires Excel 
2007 and Hotfix KB980210) 

 

Third Party Controls 
o Microsoft .NET Framework 3.5 

SP1 Runtime 
o Visual Studio Tools for Office 

3.0 

  Premier Billing requires 
Excel 2007 and Hotfix 
KB980210) 

Operating Systems 
o Windows 2000 

Professional  - 
 Microsoft .Net 
Framework not 
supported with 
Windows 2000 
Operating Systems) 

 

Other 

Business Applications 
o Microsoft Office 

2003 
o Microsoft Office 

2002/XP 
o Microsoft Office 

2000 

07/19/10 

 


